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1. Introduction 
These are the release notes for 3-SDU version 5.02. They contain a summary of 
the changes made from version 4.01 and include information that was not 
available in the documentation or Help system at the time of their publication. 

Please read these release notes in their entirety before installing 3-SDU 5.02. 
For details on upgrading systems using the network download feature see  
“7. Installing and upgrading to 3-SDU 5.02” on page 19. 

The use of “x” in a model number may be used to indicate several generations of 
the product. For example, 3-CPUx represents the 3-CPU, 3-CPU1, and 3-CPU3. 
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1.1 New software versions 

3-SDU 5.02 includes updated firmware for the products listed in Table 1.  

Table 1: New EST3 software and microcode versions 

Description Version 

3-CPUx microcode 5.02 

C-CPU microcode 1.03 

3-EAxC microcode 4.0 

3-SxDC1 microcode 4.0 

1.2 Contacting support 

Contact technical support if you encounter any difficulties during this installation. 
Please make sure you have diagnostic or log files ready before you contact us. 

Edwards 
8985 Town Center Parkway 
Bradenton, FL 34202 

T +1 800 655 4497 
F +1 866 226 2126 
E est.techsupport@fs.utc.com 

2. Operating system compatibility 
3-SDU 5.02 is compatible with the following versions of Microsoft Windows: 

• Windows XP (32-bit), Service Pack 3 

• Windows Vista (32-bit), Service Pack 1 

• Windows 7 (32-bit) 

• Windows 7 (64-bit) 

Note: 3-SDU 5.02 must be “run as administrator” with full elevated rights and 
privileges. 

3. What’s new in 3-SDU 5.02 
3-SDU 5.02 includes new features, as well as most of the features in all 
previously released versions. Additional new features and differences between 
earlier releases are as follows: 

• Support for SIGA2 detectors and modules 
• Enhanced microcode support 
• Support for the new EST3X panels 
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• SDU Help 

Support for the new EST3X panels includes: 

• Enhanced audio 
• Configurable NAC/AUX circuits 
• Power supply diagnostics 
• SFS1-CPU support (C-CPU in the SDU) 
• R Series remote annunciators 
• New operator layer configuration with four-color LEDs 
• Advanced Signature loop controller diagnostics 
• Automatic Contact ID 
• IP communications 

3.1 Support for SIGA2 detectors and modules 

3-SDU 5.02 supports SIGA2 detectors and modules, except that PCOS and PHS 
detectors do not have the same level of support as in 3-SDU 4.01.  

For SIGA2-PHS detectors, 3-SDU 5.02 does not support setting the value of the 
Operation and Alt Operation options for: Photo is AlarmSmoke | Heat is 
AlarmHeat. Table 2 lists the differences in support for SIGA2-PCOS detectors.  

Full support for these detectors will be available in a future release. 

Table 2: SIGA2-PCOS feature support differences 

 Photo: Latching 

CO: Latching 

(Personality 64) 

Photo: Latching 

CO: Nonlatching 

(Personality 67) 

Photo: Nonlatching 

CO: Latching 

(Personality 51) 

Photo: Nonlatching

CO: Nonlatching 

(Personality 68) 

Device type/CO Setting V4.01 V5.02 V4.01 V5.02 V4.01 V5.02 V4.01 V5.02 

Smoke/CO Alarm Y Y N Y N N N N 

Smoke/CO Supervisory * Y Y Y Y N N N N 

Smoke/CO Monitor Y Y Y Y N N N N 

Supervisory/CO Alarm Y N N N Y N N N 

Supervisory/CO Supervisory Y N Y N Y N Y N 

Supervisory/CO Monitor N N Y N N N Y N 

* Default configuration 

 

Please see the “3-SDU Version 4.01 Release Notes,” available at  
https://est.edwardsutcfs.com/catalog/login/. 

3.2 Enhanced microcode support 

The process of selecting versions of microcode (application code and bootloader 
code) has changed. The MicroCode tab is now in the Project Parameters dialog 
box (Configure > Project) instead of in the Cabinet Configuration dialog box. 
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Previously, you had to select a valid version of application and bootloader code 
for each potential LRM. Now, you only have to select versions for the LRMs that 
exist in the project. Because of this, when you create a new project, the 
MicroCode tab is not visible until after you add a panel to the project. 

The new MicroCode tab contains a table on the left that lists each LRM type in 
the project that has microcode. The table also shows the currently-selected 
versions of application code and bootloader code for each LRM type. When you 
select an LRM type the list on the right side of the tab changes to show the 
available versions of application code for that LRM. The SDU lists the newest 
version on top and highlights the currently-selected version. Like the previous 
MicroCode tab, the SDU selects the bootloader code version based on the 
version of the selected application code. 

 

When you open a project, the SDU examines the currently-selected versions of 
microcode. If the selected versions are not the most current versions, the SDU 
produces this warning message: “Some or all of this project’s selected 
MicroCode versions are out of date!” and offers an opportunity to automatically 
change to the latest versions, depending on the MicroCode Version Updates 
option setting (Options > Customize > Behavior tab). 

It is also possible that some of the currently-selected microcode versions are no 
longer supported. If this is the case, the SDU produces this warning: “Some or all 
of this project’s selected Microcode versions do not exist or are incompatible with 
the Brand or Marketplace.” You can ignore this warning, but certain processes 



 

P/N 270729 • REV 04 • ISS 05MAY11 5 / 34 

(DB Conversion for example) will not execute while you have invalid microcode 
versions selected. On the MicroCode tab, the invalid selections appear in red and 
are enclosed in parentheses. 

3.3 Support for the new EST3X panels 

The new EST3X panels represent the latest generation of life safety control 
panels for mid-to-large size applications. With large multiple-message displays, 
innovative controls, intuitive interface, and bold colored cabinets, these systems 
capture the imagination and catch the eye. But behind the LCD display is where 
they really shine. 

New microprocessors and chipsets take full advantage of the latest advances in 
computing technology, leading to smarter, faster, higher-capacity processing and 
more efficient designs. For example, the patented Voltage Boost™ technology 
delivers consistent voltage — even at low battery power — resulting in lighter 
cable requirements, longer wire runs, or both. This saves time and money. 

High performance processing also leads to powerful networking features and 
versatile digital audio functionality. The wide range of EST3X configurations 
includes stand-alone operation, networked operation with up to eight EST3X 
nodes, or integration with an EST3 life safety network comprising as many as  
64 nodes — complete with EST360 mass notification capabilities and display of 
security events. 

3.3.1 Enhanced audio 

EST3X panels provide a full eight channels of integrated digital audio with up to 
two minutes of on-board programmable message storage. The 3X-PMI Paging 
Microphone Interface gives live access to local as well as remote audio functions. 
Auxiliary inputs are available for mass notification operations, and you can mount 
amplifiers directly on the EST3X rail assembly. 

3.3.2 Configurable NAC/AUX circuits 

The EST3X power supply provides four output circuits that you can individually 
configure as notification appliance circuits or as auxiliary power circuits.
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The four output circuits are configured using these device types: 

• DamperControl 

• DoorControl 

• FanControl 

• Audible 

• CommonAlarmOutput 

• CommonMonitorOutput 

• CommonSupervisoryOutput 

• SupervisedOutput 

• Visible 

• ControlledAuxOutput (Controlled 
Auxiliary Output) 

 • G_Audible (Genesis Audible) 

• G_Visible (Genesis Visible) 

• G_AudibleVisible (Genesis Audible 
Visible) 

• G_CommonAlarmOutput (Genesis 
Common Alarm Output) 

• G_CommonSupervisoryOutput 
(Genesis Common Supervisory 
Output) 

• G_CommonMonitorOutput 
(Genesis Common Monitor Output)

• City_Tie 

Note: PS10-4B NAC/AUX circuits configured as auxiliary power outputs must be 
turned on using a startup rule. A rule is needed to turn them off during an AC 
power failure if, for example, they are powering non-life safety devices and you 
want to preserve battery life. 

3.3.3 Power supply diagnostics 

The Power Supply Diagnostics dialog box (Tools > Power Supply > Diagnostics) 
displays information in the following fields: 

• Total Current 

• Maximum Current in Alarm 

Each of the following fields shows the actual, minimum, maximum, previous 
1-hour average, and 24-hour average over the time that the power supply 
diagnostics has been connected: 

• NAC/AUX Current 

• Input AC Voltage 

• Battery Current 

The Battery tab displays the actual, minimum, and maximum voltages of the 
standby batteries. 
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3.3.4 SFS1-CPU support 

The SFS1-CPU (C-CPU in the SDU) supports the following network cards: 

• 3X-NET8: Gives a EST3X panel the ability to network via copper wire with a 
maximum of eight EST3X nodes (no EST3 nodes). The card supports Class 
A and Class B wiring. The 3X-NET8 adapter card provides two independent 
RS-485 circuits; one for network data communications and one for digital 
audio communications. 

• 3X-NET: Gives a EST3X panel the ability to network via fiber optic cable with 
EST3 Systems, up to a maximum of 64 nodes. The card supports Class B 
and Class A wiring. The 3X-NET adapter card provides two independent  
RS-485 circuits; one for network data communications and one for digital 
audio communications. 

• 3X-FIB8: Gives a EST3X panel the ability to network via fiber optic cable with 
a maximum of eight EST3X nodes only (no EST3 nodes). The card supports 
Class A or Class B network and Class A or Class B audio data, and provides 
single or multiple-mode network and digital audio fiber optic connections. 

• 3-FIBMB2: Gives a EST3X panel the ability to network via fiber optic cable 
with EST3 systems, up to a maximum of 64 nodes. The card supports Class 
A or Class B network and Class A or Class B audio data, and provides single 
or multiple-mode network and digital audio fiber optic connections. 

3.3.5 R Series Annunciator support 

Each EST3X panel supports the connection of up to 30 R Series remote 
annunciators (RLCD, RLCD-C, or RLED-C), up to 30 GCI graphic annunciator 
cards, or a combination of both. Each R Series remote annunciator can have two 
RLED24 expanders that contain an additional 48 LED indicators per expander. 
Each GCI card can have two GCIX expanders for an additional 48 LED indicators 
and 24 input switches per GCI. 

Note: R Series annunciator firmware version 2.0 or later is required. You can 
verify the firmware version on RLCD(-C) annunciators by pressing the Lamp Test 
button. On RLED-C annunciators and GCI card, the firmware version is marked 
on the product carton. 

Remote annunciators are managed by a modified 3-SAC built into the EST3X 
panel. This card always has a slot position of 7 and a card address of 4. To fit  
30 annunciators and all of their LEDs, switches, and pseudo points onto a single 
card, the system assigns device addresses in ranges. Each annunciator is 
assigned a range of 300 addresses. 
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3.3.6 Enhanced internal Signature loop controller 

The EST3X CPU Main board includes a single Signature loop controller (card 
address 3) that you can expand to two loops by installing an additional 3-SDC1 
card. 

The CPU Main Board loop controller: 

• Generates new pseudo point events to signal when there are more than the 
allowed number of detectors or modules installed on a Signature loop. The 
two events are “Too_Many_Devices_DataCard1_PP_03” and 
“Too_Many_Devices_DataCard2_PP_03.” 

• Generates new pseudo point events to signal when the expected map does 
not match the actual map. The two events are 
“Map_Mismatch_DataCard1_PP_03” and 
“Map_Mismatch_DataCard2_01_03.” 

• Does not support security devices (i.e., SIGA-SEC2 and SIGA-MD). 

• Does not support stand-alone alarm operation. Outputs connected to the  
CPU main board loop controller that are configured for stand-alone alarm do 
not automatically activate if an alarm occurs while the CPU and loop 
controller are not communicating. 

• Supports SIGA2 devices as per version 4.0 of the 3-SxDC, except you cannot 
program PHS detectors with the “Photo is AlarmSmoke | Heat is AlarmHeat” 
operation, or the “Photo is Supervisory | Heat is Supervisory” operation. 

3.3.7 Advanced diagnostics for the CPU main board loop controller 

We have expanded the Trouble Tables tab on the Signature Series Status / 
Diagnostics dialog box to show a “% Dirty Analysis” graph, and to allow you to 
enter comments on the selected device. For this graph, if you attempt to connect 
to the panel and download information while devices are still initializing, the 
graph will show invalid data. Always wait until the devices have finished 
initializing before retrieving data from the panel (i.e., the Sensor Initialization LED 
and the Device Supervision LED on the Current Status tab are both off.) 

In addition, we have added the following columns to the table on this tab. These 
columns apply to the EST3X CPU internal loop controllers only. 

• 1 Hr Retry Counter: The number of unsuccessful communication queries 
with the device within a one hour period. 

• 24 Hr Retry Counter: The number of unsuccessful communication queries 
with the device within a 24 hour period. 

• Base Type Fault: Indicates that the device base type in the loop controller's 
expected data table does not match the device base type in the actual data 
table. 
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• Riser Fault: Indicates a fault on the input riser of the module (i.e., 24 V riser 
of a UM configured as a two-wire smoke). 

• Sensitivity Fault: Indicates that the device sensitivity has changed un-
expectedly. 

• Device Init Fault: Indicates that the device failed the initialization process at 
startup. 

• Configuration Fault: Indicates that the device has a configuration that is not 
valid. Go into the configuration tool and review and update the devices 
configuration. 

• Invalid Address: Indicates that the device has an address that is beyond the 
allowable limit. 

• IL Feedback: Interlock feedback has timed out on a device (Chinese 
marketplace feature). 

3.3.8 Automatic Contact ID 

Depending on the configuration of your project, the SDU can automatically 
generate Contact ID strings to send to a central monitoring station (CMS). 

To use this feature your project must contain: 

• Eight or less EST3X (CAB6) panels. The Network Type option on the Project 
Parameters – Network tab must be set to “3X Only”. 

• A 3-MODCOM(P) with at least one account configured for Contact ID. 

When you add an account and attach it to a receiver configured for Contact ID, 
the SDU displays the “Auto Generate Events” check box in the Account 
Properties dialog box. This check box is checked by default. If you do not want 
the SDU to automatically generate your Contact ID strings for this account, then 
clear this check box. 

If your project meets the criteria above, after you successfully run a rules compile 
the SDU generates the necessary Contact ID strings for the project. The SDU 
inserts these strings before all of the written rules. This assures that the Contact 
ID strings are sent to the CMS before any delays in the rules are encountered. 

It is possible to override an automatically generated Contact ID string by writing a 
rule. For example, suppose there are four NACs on the EST3X power supply, 
and the SDU automatically generates a unique string for each. The SDU sends a 
“137312001” string for the trouble activation of the first NAC and “137312002“ for 
trouble activation of the second NAC. If you want to send the same CID string for 
all four NACs then you could use the following rule: 

[change message rule] 
Trouble ‘PS/NAC_01_02_*’ : +send ‘account1’ “137312000”; 
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We included only the activation portion of the send command because if you 
check “Auto Generate events” and your rule includes only a send activation, the 
SDU automatically generates the restore using the same string (“337312000” in 
the example). 

Run the CMS Messaging Report for a complete list of the Contact ID strings sent 
for each device. You can now export this report into an Excel spreadsheet file. 
Once you run the report, click the Save Report button and select Microsoft Excel 
Worksheet (*.xls) in the “Save as type” dropdown list. 

3.3.9 TCP/IP communications 

The ETH1 Ethernet card on CAB6 cabinet models lets you use Internet Protocol 
connectivity for remote programming and diagnostics. 

We have added the Cabinet Configuration – IP Configuration tab to let you to 
configure IP connectivity. 

The following fields were added in the Communications Functions and the Select 
a Signature Loop for Mapping dialog boxes to support TCP/IP communications: 

• Connection Type 

• IP Address 

• Port Address 

• Cabinet 

3.3.10 Remote write unlock 

To download application, database, and boot loader code using an IP 
connection, you must first unlock the panel. You can do this by activating a write 
unlock for the panel. 

To activate a remote write unlock via the panel’s menu: 

1. Go to the Activate menu on the panel. 

2. Select Remote Write Unlock. 

3. Select the panel (or select ALL). 

4. Start the download. 

The panel automatically times out the unlock if there is no download activity for 
15 minutes. 

To restore a remote write unlock via the panel’s menu: 

1. Go to the Restore menu on the panel. 

2. Select Remote Write Unlock. 

3. Select the panel (or select ALL). 
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You can also activate and restore an unlock using correlations (see the SDU 
Help for information on the ActivateRemoteWriteUnlock and 
RestoreRemoteWriteUnlock commands). 

3.3.11 Remote read lock 

The panel allows you to lock out remote reads (i.e., diagnostics information) via 
the IP connection. This is designed to prevent unauthorized access to the panel. 

To activate a remote read lock via the panel’s menu: 

1. Go to the Activate menu on the panel. 

2. Select Remote Read lock. 

3. Select the panel (or select ALL). 

You can restore the lock via the panel. 

To restore a remote read unlock via the panel’s menu: 

1. Go to the Restore menu on the panel. 

2. Select Remote Read lock. 

3. Select the panel (or select ALL). 

Programmers can also activate and restore the lock using correlations (see the 
SDU Help for information on the ActivateRemoteReadLock and 
RestoreRemoteReadLock commands). 

3.3.12 New commands 

Version 5.02 adds the following new commands for EST3X cabinets only: 

• ActivateRemoteReadLock: Disables IP read communications between the 
SDU and the panel. 

• ActivateRemoteWriteUnlock: Allows write capability using IP 
communications between the SDU and the panel. 

• RestoreRemoteReadLock: Allows IP read communications between the CU 
and the panel. 

• RestoreRemoteWriteUnlock: Disables the write capability using IP 
communications between the SDU and the panel. 

• NAC20: Sets the audible tone pattern on a specified NAC to the 20 pattern: 
audio sounds at 20 beats per minute (1-1/2 seconds on, 1-1/2 seconds off). 

• NAC120: Sets the audible tone pattern on a specified NAC to the 120 pattern: 
audio sounds at 120 beats per minute (1/4 second on, 1/4 second off). 

• NACTemporal: Sets the audible tone pattern on a specified NAC to the 
temporal pattern: audio sounds in a 3-3-3 pattern. 
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3.3.13 Items incompatible with EST3X panels 

The new EST3X panels are not designed to support security and access control. 
You cannot add 3-SAC, CRC, CRCXM, or KPDISP hardware to a EST3X panel. 
You cannot add SIGA-SEC2 and SIGA-MD modules to loop controllers on 
EST3X panels. 

However, if your project has a mix of EST3X and EST3 panels, the EST3X 
panels can support security and access control points indirectly in that they are 
displayed on, and can be controlled from, the EST3X panels. 

Note: Do not use partitions on EST3X panels. 

3.4 SDU Help 

For all features, the 3-SDU 5.02 provides context sensitive help topics. Pressing 
the F1 key displays a help topic that corresponds to the location and task being 
performed. 

The 3-SDU 5.02 Help requires that you have Internet Explorer 6 or later installed. 
The compiled HTML Help file is not compatible with other Web browsers. 

4. Language support 
The following tables detail the language support available in 3-SDU version 5.02. 

Table 3: Language Support on projects containing EST3 panels only  
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Finnish 
(Finland) 

  X    
     

French 
(Canada) 

X X     
     

German 
(Standard - Germany) 

  X    
     

Hebrew 
(Israel) 

X    X  
     

Italian 
(Italy) 

X  X    
     

Korean  
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Korea) 
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Table 4: Language support on  
projects containing EST3X panels  
only, or a combination of EST3X  
and EST3 panels 

 

 

Language U
S

 

C
an

ad
a 

English (USA) X X 

French (Canada) X X 

Portuguese (Brazil) X  

Spanish (Mexico) X  

 

Note: The KPDISP provides a single layout for use in the markets and languages 
served by the American, European, Middle East, and Australian marketplaces. 

4.1 Bilingual language character sets (for EST3 panel only projects) 

When a primary and secondary language are selected, both languages must be 
supported in the same font table. 

Table 5: Bilingual character sets 

EST3 code page Bilingual language sets 

1250 (Eastern Europe) Croatian, Czech, English, Hungarian, Polish, Slovak 

1251 (Cyrillic) English, Russian 

1252 (Western Europe) Danish, Dutch, English, Finnish, French, German, Italian, 
Norwegian, Portuguese, Spanish, Swedish 

1254 (Turkish) English, Turkish 

1255 (Hebrew) English, Hebrew 

 

4.2 Printer code pages 

The following table shows the DOS code page support required to allow you to 
print in the local language. Since not all of Windows characters are available on 
the DOS printer, some characters may not be supported. 

Table 6: Printer code pages 

EST3 code page Printer code page 

936 (Chinese Simplified) Windows Code Page 936 (GB) 

949 (Korean) Windows Code Page 949 (Extended Wansung) 

950 (Chinese Traditional ) Windows Code Page 950 (Big 5) 

1250 (Eastern Europe) DOS Code Page 852 
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EST3 code page Printer code page 

1251 (Cyrillic) DOS Code Page 866 

1252 (Western Europe)  DOS Code Page 850 

1254 (Turkish) DOS Code Page 857 

1255 (Hebrew) DOS Code Page 862 

1256 (Arabic UL) DOS Code Page 864 

 

5. Software versions and compatibility 

5.1 LRM compatible versions 

You must upgrade all applicable microcode versions to take full advantage of the 
new features offered in 3-SDU 5.02. 

Table 7: 3-SDU 5.02 software compatibility 

LRM Oldest 
version * 

Shipping 
version 

Medium Part 
number 

3-ASU 1.4 3.4 CD 3-SDU 

3-AADC 1.4 3.41 CD 3-SDU 

3-AADC1 1.4 3.71 CD 3-SDU 

3-CPUx 5.02 5.02 CD 3-SDU 

3-EASC/3-EADC 3.4 3.6 CD 3-SDU 

3-FTCU 1.0 1.2 Chip 190156 

3-FTCU 1.4 3.4 Chip 190254 

3-IDC8/4 1.1 3.6 Chip 190159 

3-LDSM 1.0 3.0 Chip 190153 

3-MODCOM(P) 3.0 3.6 CD 3-SDU 

3-OPS 1.0 3.0 Chip 190158 

3-PPS 1.0 3.61 Chip 190157 

3-BPS 1.0 3.61 Chip 190157 

3-BBC 3.0 3.6 Chip 190157 

3-RS485-A/B  1.5 PAL Chip 190271 

3-RS485-R     

3-SSDC/3-SDDC 1.52 3.32 CD 3-SDU 

3-SSDC1/3-SDDC1 1.52 4.0 CD 3-SDU 

3-SAC 3.1 3.6 CD 3-SDU 

3-ZA15 1.1** N/A Chip 190151 
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LRM Oldest 
version * 

Shipping 
version 

Medium Part 
number 

 1.3 N/A PAL Chip 190191 

3-ZA20A 1.4 3.6 Chip 190252 

 1.4 1.4 PAL Chip 190191 

 1.0 1.0 PAL Chip 7400068 

3-ZA20B 1.4 3.6 Chip 190252 

 1.4 1.4 PAL Chip 190191 

 1.0 1.0 PAL Chip 7400068 

3-ZA30 1.1** N/A Chip 190151 

 1.3 N/A PAL Chip 190191 

3-ZA40A 1.4 3.6 Chip 190252 

 1.4 1.4 PAL Chip 190191 

 1.0 1.0 PAL Chip 7400068 

3-ZA40B 1.4 3.6 Chip 190252 

 1.4 1.4 PAL Chip 190191 

 1.0 1.0 PAL Chip 7400068 

3-ZA90 1.4 3.6 Chip 190252 

 1.4 1.4 PAL Chip 190191 

3-ZA95 1.4 3.6 Chip 190252 

 1.0 1.0 PAL Chip 7400068 

C-CPU 1.0 1.03 CD 3-SDU 

CRC 1.3 1.7 CD 3-SDU 

KPDISP 1.0 1.6 CD 3-SDU 

CDR-3 2.0 3.5 Chip 190071 

RLCD 2.0 2.01 Chip RLCD 

RLCD-C 2.0 2.01 Chip RLCD-C 

RLED 2.0 2.01 Chip RLED 

GCI 2.0 2.01 Chip GCI 

*Oldest version still compatible with the current version of SDU 

**Version 1.12 required for stand-alone mode disabled feature. To obtain V1.12, request a 
deviation version for part number 190151 from Technical Support. 

Notes 

• 3-CPUx V5.02 microcode cannot reside on the same network as earlier 
3-CPUx microcode. To use V5.02, all panels must be upgraded to V5.02. 
Networks with 3-CPU microcode version 3.0 or later can be upgraded with the 
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SDU by using the network download function. See “8. Upgrading microcode 
versions to V5.02” on page 24. 

• The 3-CPU3 is 100 percent backward compatible with, and can be installed 
on the same network as, 3-CPU1 and 3-CPU. The 3-CPU3 and 3-CPU1 
require version 5.02 microcode. 

• 3-FTCU firmware comes in two noninterchangeable forms. Part 190254 
cannot be used to update Part 190156, and vice versa. 

5.2 SDU database compatibility 

Use the 3-SDU 5.02 to generate databases for the LRMs listed in Table 8. 

Table 8: LRM microcode supported by 3-SDU 5.02 

LRM SDU supported microcode versions 

3-AADC V1.4, V3.0, V3.1, V3.41  

3-AADC1 V1.4, V3.0, V3.1, V3.41, V3.6, V3.7, V3.71 

3-ASU V1.4, V3.0, V3.1, V3.4 

3-CPU V5.02 

3-EADC/EADC V3.4, V3.6, V4.0 

3-MODCOM(P) V3.0, V3.1, V3.11, V3.12, V3.6 

3-SAC V3.1, V3.5, V3.6 

3-SSDC/SDDC V1.52, V2.1, V3.32 

3-SSDC1/SDDC1 V1.52, V2.1, V3.32, V3.6, V3.7, V3.71, V3.83, V4.0 

C-CPU V1.03 

CRC V1.3, V1.4, V1.5, V1.6, V1.7 

KPDISP V1.0, V1.1, V1.2, V1.3, V1.4, V1.5, V1.6 

 

5.3 LRM and 3-CPU V5.02 microcode compatibility  

The following table identifies the latest version of LRM microcode that is 
compatible with 3-CPUx V5.02 microcode. We recommend that you use the 
latest version of LRM microcode. 

Table 9: LRM and 3-CPU V5.02  
microcode compatibility 

LRM Microcode version 

3-AADC V3.41 

3-AADC1 V3.71 

3-ASU V3.4 
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LRM Microcode version 

3-EASC V4.0 

3-EADC V4.0 

MODCOM(P) V3.6 

3-SAC V3.6 

3-SSDC V3.32 

3-SDDC V3.32 

3-SSDC1 V4.0 

3-SDDC1 V4.0 

C-CPU V1.03 

CRC V1.7 

KPDISP V1.6 

6. 3-CPUx V5.02 microcode updates 
• Added support for SIGA2 detectors. 

• Added IP address in the revision reports. 

• Allows the SDU to determine the panel type across the network to avoid 
EST3X databases to be downloaded into EST3 panels. 

• Modified code to synchronize reboots to allow the SDU to connect or 
disconnect from a panel when downloading to multiple panels via TCP/IP. 

• Fixed the AND group details report. 

• Fixed an issue where a warning was not displayed when enabling a device 
that is in alarm. 

• Improved network communication with following updates. 

• Check correct termination and packet length in data packet. 

• Change stop bit from one bit to two bit value. Add new logic to detect token 
failure that can happen on background. 

• Changed network reconfigure protocol to bring network online in EST3X 
panels on class A network. Added same protocol changes in reconfiguring 
panels in EST3 firmware. 
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7. Installing and upgrading to 3-SDU 5.02 

7.1 Upgrading 

It is essential to uninstall previous versions of the SDU, either using the shortcut 
in the Windows Start menu or using the Control Panel, before installing 3-SDU 
5.02. Any saved projects in the Projects folder are not removed during uninstall. 
If you are installing into the same directory as the previous installation, the 
installation does not overwrite the old Projects folder. If you are not installing into 
the same directory as the previous installation, then you have to import your old 
projects. 

7.2 Installation prerequisites 

The only prerequisite for installing the SDU is the HASP Device Driver. The 
HASP4 installs if you are running on a 32-bit system, while the Sentinel HASP 
installs if you are running on a 64-bit system. 

To begin loading the requirements, double-click the SDU setup.exe file. When 
the Requirements window appears, click the Install button and step through the 
HASP installation. 

Figure 1: The Requirements window 
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• The HASP requirement only appears during a first-time installation. Any 
subsequent installations of the SDU application do not display the HASP 
requirement, because it has been installed previously. 

• The SDU application begins installing immediately after the HASP completely 
installed. 

• The HASP does not uninstall if you uninstall the SDU. If you need to uninstall 
the HASP, use the Control Panel. 

7.3 Installing the SDU 

The SDU application begins installing immediately after all of the HASP 
Requirement has completely installed. 

To install the SDU: 

1. Finish loading the HASP Requirement, if you have not previously loaded it. 

2. The 3-SDU installation wizard starts, and displays the welcome page. Click 
Next. 

 

3. The License Agreement page appears. Click Yes to accept the license. 
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4. The Choose Destination Location page appears. Click Browse to select 
another folder or click Next to choose the default path C:\FAST\3-SDU\. 

 

5. The Ready to Install page appears. Click Install to begin transferring files. 
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7.4 Installing the Borland Database Engine 

The Borland Database Engine installs as a part of the SDU installation. You can 
click Browse to select another folder, or click OK to choose the default path 
C:\Program Files\Common Files\Borland Shared\BDE. While you can install the 
BDE in any location, we do not recommend changing the default path. 

To install the Borland Database Engine: 

1. Do not click the Cancel button, because any attempt to cancel the BDE 
installation generates an error. 

 

2. If the BDE is already installed in the default directory, it overwrites the 
previous installation. You can also install the BDE in multiple directories. 
Neither of these scenarios affects the operation of the SDU application. 

3. If you have another application window open while you are installing the SDU, 
the BDE installation window goes behind other active windows. When this 
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happens, the SDU installation remains in a wait mode until you activate the 
BDE dialog box again. To do so, select the BDE task from the taskbar and 
continue the installation. The best practice is to close all applications and 
monitor the SDU installation. 

 
 

Note: Increase the Zoom in this PDF if you want to see details in this screen 
shot. 

4. Click on Borland Database Engine in the taskbar to activate it, and then click 
OK. 

 

5. After the Borland Database Engine finishes installing, the Finish page  
appears. Click Finish to complete the SDU installation. 
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8. Upgrading microcode versions to V5.02 

8.1. 3-CPUx version 5.02 

You must download both the new application and bootloader code to all panels in 
the system. 

Project version numbers are embedded in each project file. Because the Save As 
command creates a new version number that is different than the embedded 
version, you must use the following procedure to install V5.02. Please follow 
these steps in the correct order to upgrade the hardware and software in your 
system. 

Note: When adding an EST3X panel to an EST3 Network, upgrade your EST3 
microcode to 5.02 before connecting EST3X nodes to the EST3 network. 

Note: Do not mix different versions of 3-CPUx microcode on the same network. 
Upgrade an existing system by carefully following this procedure. 

To upgrade V3.0 or later to V5.02: 

1. Install SDU version 5.02. 

2. Choose Project > Open and select your project from the Open Project dialog 
box. Click OK to open the project. 

3. Click OK to upgrade the microcode of your project. 

4. Save your project as a new version, using the Save As command on the File 
menu. 

5. Choose Rules > Compile to recompile your project. 
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6. Choose Tools > DB Conversion > All Databases to create databases for the 
loop controllers and cabinets. 

7. Choose Project > Save to save the recompiled project. 

8. Choose Tools > Communications and select Network for the Download mode. 

9. From the LRM Type Display Filter group, select 3-CPU. From the File Display 
Filter group, select three options, Boot loader code, Application code, and 
Database for each panel. (Do not select any other option.) 

10. On Class B networks, connect the SDU to the first CPU (sometimes called 
the service panel). On Class A networks you can connect the SDU to any 
node on the network. 

11. Click Download and Start to network download. 

8.2 Upgrading firmware on 3-DSDC(1)(C), 3-SDDC(1)(C), and 3-AADC(1) 
loop controllers 

You must upgrade the 3-CPUxs before upgrading the loop controllers. 

You can upgrade the loop controllers using network downloads. 

If the bootstrap download fails, or if the steps are performed out of order, you 
must cycle the power on the panel and restart the upgrade by downloading the 
bootstrap code again. 

You must complete each of the following steps in separate download sessions. 

To upgrade the loop controllers: 

1. Download the 3-SSDC/3-SDDC/3-AADC bootstrap to each LRM. (Download 
the bootstrap only; do not download the application code or database.) 

2. From the 3-LCDXL1C, issue a restart command for all panels. 

3. Download the 3-SSDC/3-SDDC/3-AADC application code. 

4. Download the 3-SSDC/3-SDDC/3-AADC loop controller databases. 

8.3 Upgrading the 3-ASU 

When upgrading the 3-ASU, we recommended that you do so in the following 
order: 

1. Download the boot code 

2. Download the application code 

3. Download the database 
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8.4 Upgrading the CRC 

When upgrading the CRC/CRCXM, we recommend that you do so in the 
following order: 

1. Download the SDU application code 

2. Download the SDU database 

3. Download the ACDB database (from the CRC Administration tab, select the 
Destination DB Init task) 

Note: Upgrading the code to a CRC disables the access functionality for the door 
being controlled until you use the ACDB to download its corresponding database. 

9. Running 3-SDU 4.01 and 3-SDU 5.02 on the same 
computer 
The “Photo is AlarmSmoke | Heat is AlarmHeat” operation on PHS detectors is 
not supported in 3-SDU 5.02. If this feature is required then you must configure 
your system to run both 3-SDU 4.01 and 3-SDU 5.02 on the same computer. 

Install 3-SDU 4.01 and 3-SDU 5.02 into different folders and make note of the 
locations. You can install them anywhere, but for this example 3-SDU 4.01 is 
installed into the default C:\FAST\3-SDU folder and 3-SDU 5.02 is installed into 
C:\FAST\3-SDU501 folder. 

Once both versions of the SDU are installed, edit the C:\WINDOWS\SDU.INI file 
using Notepad or another text editor. 

Using the example above, the following should appear at the top of the SDU.INI 
file: 

[SDU Directories] 
AppDirectory=C:\FAST\3-SDU 
IDAPIVer=2.50 

Edit the file to match the following, and then save it: 

[SDU Directories] 
AppDirectory=C:\FAST\3-SDU501 
AppDirectory04.01.00=C:\FAST\3-SDU 
IDAPIVer=2.50 

Now 3-SDU 4.01 and 3-SDU 5.02 can run from their own folders and have their 
own list of projects. 
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10. Reminder of NFPA 72 testing requirements 
When changes are made to site-specific software, the following shall apply: 

• All functions known to be affected by the change, or identified by a means 
that indicates changes, shall be tested 100 percent. 

• In addition, 10 percent of initiating devices that are not directly affected by the 
change, up to a maximum of 50 devices, also shall be tested and correct 
system operation shall be verified. 

• A revised record of completion in accordance with NFPA standards shall be 
prepared to reflect these changes. 

• Changes to all control units connected or controlled by the system executive 
software shall require a 10 percent functional test of the system, including a 
test of at least one device on each input and output circuit to verify critical 
system functions such as notification appliances, control functions, and off-
premises reporting. 

11. Known issues 
The following known issues exist for SDU version 5.02. 

11.1 Windows Vista and Windows 7 

Some features in the SDU require you to run the program with higher privileges  
in the Execution Level scheme for Windows Vista or Windows 7. However, when 
you run at the higher privilege level, the User Account Control dialog box 
appears. 
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Figure 2: User Account Control 

 

This appears because the SDU is not currently certified with electronic signature 
verification software. Click Allow to run your SDU with full functionality. 

11.2 Changes before DB Conversion and download to the panel 

Many changes, such as changing or deleting devices, DACT accounts, etc. that 
are used in a rule, can cause serious panel operation problems if you download 
the database directly to the panel. Always compile the rules after you have made 
changes to objects, and before you run a DB Conversion and download the 
database to the panel. 

11.3 Changes made after installation 

If you copy files into the installation directories after the installation, or create files 
while running the SDU, the system will not uninstall those files and the directory 
tree containing them during the uninstall process. This includes all project files 
(by design) and settings used relating to projects. We recommend exporting your 
project files to another location before uninstalling the SDU. 

11.4 Stand-alone alarm 

“Stand Alone Alarm” in the Signature Series module report does not apply to 
internal loop controllers on the CAB6 and will be removed in a future release. 

11.5 QuickStart concurrent installation 

If you install the 3-SDU 5.02 after installing the QuickStart QS-CU, the SDU 
installation overwrites the C:\WINDOWS\system32\dunzip32.dll and 
C:\WINDOWS\system32\dzip32.dll files. The SDU uses newer versions of these 
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files that the QS-CU cannot use, so if this happens the import of QuickStart 
projects into the QS-CU will fail. QuickStart will be rebuilt to use the correct files 
in a future release. Any of the following workarounds will solve the issue: 

 Before installing the 3-SDU 5.02, copy the 
C:\WINDOWS\system32\dunzip32.dll and 
C:\WINDOWS\system32\dzip32.dll from the Windows directory to the 
QuickStart directory. 

 Manually delete C:\WINDOWS\system32\dunzip32.dll and 
C:\WINDOWS\system32\dzip32.dll, and reinstall QuickStart after installing 
the SDU. 

11.6 Fonts and resolution 

You must run the SDU on a computer with a resolution of 1024 x 768 or greater  
and use normal size fonts, that is, DPI setting: Normal size (96 DPI). If you use 
any other font setting the SDU buttons may not be accessible. 

11.7 Using time controls to disable zone groups 

Members of a zone group are not disabled if the zone group is disabled via a 
time control. Do not use time controls to disable a zone group. 

11.8 Incomplete AC fail example in Help file 

The example rule shown in the “ACFail event type” Help topic is incomplete 
because the device must be part of an AND group. The following is a better 
example of AC Fail event programming. 

{******************** GENERAL ACFAIL ********************} 

[GENERAL ACFAIL – RULE 1] 
ACFAIL 'AC_Brownout_0<N:1-8>_02' : ON 'LOGIC_ACFAIL' ; 

[GENERAL ACFAIL – RULE 2] 
RLYCFG 'LOGIC_ACFAIL' : ACTIVATE 'AND_ACFAIL' ; 

[GENERAL ACFAIL – RULE 3] 
CMSFIRSTTROUBLE : ACTIVATE 'AND_ACFAIL' ; 

[GENERAL ACFAIL – RULE 4] 
MON 'AND_ACFAIL' : +SEND 'ACCT_1' MSG "130100000" , 
                   -SEND 'ACCT_1' MSG "330100000" ; 

To program a general AC Fail event response: 

1. Create an AND group. Label the AND group: AND_ACFAIL. Do not assign 
any members, set Activation Number to 2, and set Activation Event to  
Q4 – Monitor (All Others).  

2. Create a logical output. Label the logical output: LOGIC_ACFAIL.  
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3. Write a rule that activates the logical output (LOGIC_ACFAIL) when any AC 
Fail device type activates. See General ACFail – Rule 1. 

Note: In this example there are eight control panels (eight AC Brownout 
pseudo points, one for each panel). 

4. Write a rule that increments the AND group activation counter when the 
LOGIC_ACFAIL logical output is activated. See General ACFail – Rule 2. 

5. Write a rule that increments the AND group activation counter when the CMS 
First Trouble Response pseudo point activates. See General ACFail – Rule 3. 

6. Write a rule that transmits (sends) the general AC Fail event activation code 
when the AND group activates and the general AC Fail event restoration code 
when the AND group restores. See General ACFail – Rule 4. 

11.9 Time synchronization 

3-CPU Version 03.10.00 has a known issue with the time synchronization 
command. If your system has Time Synchronization > System Time Source set 
to 3-LCD User Interface, then any communication with the 3-CPU will cause the 
system to reboot. We recommend that when you use 3-SDU 5.02 you set Time 
Synchronization > System Time Source to Input Circuit. 

11.10 Drill routing on EST3X cabinets 

The Drill command, when initiated from an EST3 panel, follows the network 
routing specified by the Drill option (Configure Cabinet > Network Routing tab). 
On EST3X panels, however, the Drill command is sent to all other panels 
regardless of the network routing specified by the Drill option. 

11.11 Compatibility with FireWorks version 1.60.01 and earlier 

FireWorks versions 1.60.01 and earlier have a compatibility issue with 3-SDU 
version 4.01, regarding data imported from CO devices and split configuration 
modes on SIGA2 model detectors only. Since FireWorks does not recognize the 
CO devices or elements in a split configuration, it reports “undefined errors” for 
those devices/elements. Note: Split configurations are selected in the Operations 
option on the Signature Series Configuration – Detectors tab. 

The device/element activation produces the following results: 

• SIGA2-HCOS activations import as a normal Heat detector activation. CO 
activations import as undefined errors. 

• SIGA2-PHCOS activations import as a normal Photo detector activation. CO 
activations import as undefined errors. 

• SIGA2-PCOS activations import as a normal Photo detector activation. CO 
activations and supervisory activations import as undefined errors. 
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• SIGA2-PHS activations import as a normal Photo detector activation. If the 
device is configured as anything other than ‘Photo/Heat is Alarm’ activations 
import as undefined errors. 

• SIGA2-COS activations import as undefined errors. 

You can verify the data in your import file from the SDU Import window. Click the 
Verify OXP File button to view data in the OXP file that FireWorks cannot 
understand. See Figure 3. 

Figure 3: SDU Import errors (types 141 and 142) 

 

When the import finishes, FireWorks lists the devices that it could not define. See 
Figure 4. 
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Figure 4: SDU Import undefined device messages 

 

Since FireWorks cannot understand these devices, it does not include them in 
the System Builder tree. Therefore, the device list may no longer be numbered 
logically. See Figure 5. 
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Figure 5: System Builder sequence interruption due to unrecognized devices/elements 

 

When one of these devices activates, FireWorks annunciates the event as 
“undefined” in the System Control window. The messages appear in red in the 
Event Action and Event List Action panes, are similar to an alarm event, and 
identify the event as “undefined alarm” or “undefined error.” 

11.12 Remote annunciator addressing 

The addresses for RLCD(-C) remote annunciators, RLED-C remote 
annunciators, and GCI graphic annunciator interface cards connected to a panel 
must be consecutive starting with address 1. For example, if you have 12 
RLCD-C annunciators, number them from 1 to 12. 

11.13 Card communication faults after downloading 

The panel may display one or more card communication fault events for a brief 
period after you finish downloading. These communication fault events occur 
because the CPU is not waiting for the option cards to finish updating before 
closing the communication session. Once the option cards finish updating, the 
communication fault events will restore automatically. 
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11.14 Exception events after downloading only the CPU database 

Downloading only the CPU database may produce an Exception event and 
cause the EST3X panel to continually reboot. To prevent this, after downloading 
the CPU database you must also download the Signature loop controller — in the 
same download session.  

Until this issue is resolved in the next release, disconnect the SLC field wires 
from the CPU main board, restart the panel, and then download the updated 
CPU database and loop controller database directly to the CPU main board. After 
you finish, reconnect the SLC field wires. 

11.15 R Series remote annunciator group details 

The following functions for R Series remote annunciators are not enabled at this 
time: 

• Zone group details 
• AND group details 
• Matrix details 
• Service group details   


